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Why Microsoft Excel Visual Basic for Applications?

Microsoft Excel VBA allows for automating tasks in Excel and provides
a full programming environment for data analysis.

Excel VBA is commonly used in high finance and frequency trading
applications for creating and validating financial models.

Using Excel VBA will be our first practice with programming and allow
us to explore fundamental programming concepts of commands,
variables, decisions, repetition, objects, and events.
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Excel Visual Basic for Applications (VBA)

w

Macros
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Visual Basic for Applications (VBA) is a programming language
allowing users to build their own functions, automate tasks in
Microsoft Office, and develop customized code.

The language has been part of almost all versions of Office for over 20
years.

VBA allows for expanding the capabilities of Excel and adding user-
interface elements (buttons, lists) to your spreadsheet.

A macro is a recorded set of actions that is saved so that they can be
easily executed again.

If you do the same set of actions repetitively, then creating a macro
allows for doing all those actions with one command.

Macros are accessible under the View tab in the Macros group or
the Developer tab.

Macros are converted into VBA programs.
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Developer Tab
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Recording a Macro

The Developer tab contains
icons for performing VBA and
macro development.

Excel Options E2

To add the Development tab, e
gotoFile, Options, ]
Customize Ribbon and
make sure it is checked beside
Developer.

To record a macro, under View select, Macros -> Record Macro.

 Excel will record your actions until you select Stop Recording.
= Note: Cursor movement is not captured.

Record Macro [7 == Macro names cannot contain spaces or begin

with a number.

Macro name:
Boldltalics

ot It is recommended to use
<t [m Ctrl+Shift+Key for a Shortcut key so that
Store macro in: you do not override built-in shortcuts.

This Workbook z] . .

Macros can be created in a given workbook or
a Personal Workbook allowing them to be
used in multiple workbooks.

Description:
Makes a cell be both bold and italics)

oK Cancel |
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Using a Macro
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Macros Question

Use a macro in the following ways:

1) With the shortcut key if defined Hesie BB
Macro name: !
2) Assign a macro to a button or on the toolbar | goasicl [ [ e ]
. i i Stepinto |
3) Under Macros, Select View Macros |
then pick the macro and Run. 3
Delete |
) Options... |
Macros in: | All Open Workbooks 3
Description
Makes a cell be both bold and italics.
Cancel |

Question: Select a TRUE statement.

A) A macro can be created without assigning it a shortcut key.
B) A macro will record cursor movements.

C) Macros can be created in an individual workbook or in a personal
macro workbook so they can be used in multiple workbooks.

D) A macro can have only one command it executes.
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Adding Macro to Quick Access Toolbar
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Try it: Macros

Add a macro to The Quick Access Toolbar under File, Options,
Quick Access Toolbar. =

v

macro icon

Quick Acces Tolear

B4-20c Layout  Formulas|

Question: Create a macro that does the following tasks:
* Bolds the cell and makes the font Courier 20.

Record Macro

Co- s

* Sets the cell background to orange. e
) yFoma
* Centers the text in the cell. Shortaut key:
* Use ashortcut of Ctrl+Shift+b. . S
* Add it to the Quick Access Toolbar. This Workbook &l

Description:
Bold, Courier 20 font, centre text|

Try-out your macro using the shortcut key,

[ o Cancel

toolbar, and from the macro dialog.
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Saving Workbook with Macros
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Macro Security

Excel now forces workbooks with macros to be saved in Excel Macro-
Enabled Workbook (* . x1sm) format.

Saving a workbook with macros in regular format gives this error:

Microsoft Excel
The following features cannot be saved in macro-free workbooks:
0 * VB project
To save a file with these features, click No, and then choose a macro-enabled file type in the File Type list.

To continue saving as a macro-free workbook, click Yes.

] Lo

Since macros can execute any code, they have been a target for virus
writers. Understanding the source of the Excel spreadsheet that
contains macros is important when deciding to run them or not.

Excel has macro security settings to allow you to enable or disable
running macros. Spreadsheets with macros often will generate a
warning when opening them:

I SECURITY WARNING Macros have been disabled. Enable Content x |
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Macro Security Settings
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Macros: Implementation

The default security is =
Disable all macros with -
notification that prevents e || e

macros from running but
displays a warning allowing
you to enable them.

Macro Seting:

One of the biggest issues
with macros is security and
making sure you are only
using macros from a
trusted source.

Macros are converted to Visual Basic

- =
MyFormat [ [ Run
R — | (i

Can edit macro code and create your (T

own code. —

_| | options...

Under the Developer tab, select Maeerve [0 cpenviothonts [

Macros then Edit macro to modify Bold, ourier 20 font centre et

the code. 1
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Visual Basic Editor
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Visual Basic Editor Screenshot

Visual Basic Editor (VBE) allows editing visual basic code and is a
complete integrated development environment (IDE).

Users can create and edit macros as well as other Visual Basic code
with the editor.

To open the VBE, under Developer tab->Visual Basicor
Alt+F11.

= ™= ®JRecord Macro R Import

] =hl-f b{‘Epyopemas ?[

8 ¢

= = = = .,
=[] use Relative References ] View Code 1) Expansion Packs
Visual Macros B Add- Bxcel COM  Insert Design Q‘ Source *=
Basic 4 Macro Security ins  Add-ns Add-Ins |~ |Mode| (3] Run Dialog
Code Add-Ins Control. XML

Ll (Code)) ==
4 Ele fdt Vew Imet Fomat Debug Run Tools Adddns Window Help .8 x
Ra-d Do) naRISEY » @ !
Project - VBAProject X [[Tconersn <] [MyFormat =l
m=EE 2 [ T 5w sorareaiicsn =
@ & Solver (SOLVERXLAM
@ roject (i s
B ooyt 1 ans s Project Explorer
e
ey .
e window
" i End Sub
| R
‘Aohabetic | categorized | Bold,
= Code window
Propertles Vith Selection.Font
== |

window |

Immediate window

ﬁgm lﬁi
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Object Browser
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Macro Code in Visual Basic Editor

Object browser allows for exploring objects and methods (the
application programming interface (API)) of Excel VBA. Open with F2.

a E=3EcE =]
4§ File Edit View Inset Format Debug Run Tools Addns Window Help -8 %
E&-ud » ) g

Project - VBAProject Ao ERBEEE]

oE|3 ] —
= -] AlY

[ 8 Vomporet v - Als)

& & vBAProject (vba.xlsm . | Classes Members of Application’

25 Mcrosoft Excel Objeq = (@ <globals> » | ActivateMicrosonanp

) Shecti (moao) |8 Abovorvorago I85! Actwecon
) Sheet? (formCon |83 Action (&5 ActiveChart
Sty (@ acons (68" ActivencryptionSession
& Addin &' ActivePrinter
Propertis - Sheet? X | adoins (6" ActiveProtectecViewWindow

[Sheetz Worksheet <] |& Adains2

Aphabetic | Cotgorzed | @ rasimers (8 ActveWinoow
o o[ Movetanges 'S asscusamus
playpogetieiFolse - A
Applcat ot
DisplayRightTol False & Application 125" Addins

& Areas &' Addins2
& AutoCorrect § AerCalculate
= || |&2 AutoFiter 25" AlertBeforeOverwriing
& AutoRecover B AtStartupPath
ues ~ I8 At secioarTme

ensbleFormatCeTrue
ensbleOutining Faise

0- xiNoRestrc Object
formControls

readkonly
Srolices Member of Excel Application

Subroutine with name and no arguments

|

Sub BoldItalics()

oh bola ana ralics. € Comments start with '

Ctrlm

Selection.Font.Bold = True <+— Every statement is on its
SEleccxoOonOcalxc = True .
End Sub own line.

Dot notation to
separate "items"
(objects, methods,
properties).




DATA 301: Data Analytics (19)

WITH Statement in Visual Basic Code
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Visual Basic Editor: Immediate Window

Sub MyFormat ()
; WITH syntax simplifies typing same
object many times.

Selection.Font.Bold = True
Vith Selection.Font
.Newe = "Courier New"
.Size = 20
.Strikethrough = False
.Superscript = False
.Subscript = False
.OutlineFont = False
.Shadow = False
.Underline = xlUnderlineStyleNone
.ThemeColor = xlThemeColorLightl
.TintAndShade = 0
.ThemeFont = x1ThemeFontNone
End Vith
Vith Selection.Interior
.Pattern = xlSolid
.PatternColorIndex = xliutomatic
.ThemeColor = x1ThemeColorAccent2
.TintAndShade = 0
.PatternTintAindShade = 0
End Vith

These lines all apply to
Selection.Font.

The Immediate window allows entering of single line commands.
* Use PRINT or ?

* In code, use Debug.Print to print to immediate window.

Immediate

? "Hello world!'"™
Hello world!
? Range ("A2") .Value
1
Range ("A2") .Value = 10
? Range ("A2") .Value
10
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Try it: Immediate Window
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Challenge Try it: Create Macro in VBE

Question: Try do these actions using the immediate window:
¢ 1) Print"Hey There!"
 2) Calculate the answer of 765 * 309.
¢ 3) Select a cell then call the macro RedItalics.
¢ 4) Change the value of cell B4 to "DATA".
¢ 5) Change the value of cell A6 to 100.

Question: Copy the MyFormat macro and edit to produce a new
macro called RedUnderline that:

¢ Underlines the text in the cell.

* Makes the cell background red.

« If the cell was bold or italics before, resets to not have bold and italics.

Hints:
* Underline property in Excel is Font . Underline and can set to constant
x1UnderlineStyleSingle.
* Can change background color with Interior.Color and set to

RGB (redValue, greenValue, blueValue) where the colorvaluesare
numbers from 0 to 255.
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Introduction to Programming
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Variables

An algorithm is a precise sequence of steps to produce a result. A
program is an encoding of an algorithm in a language to solve a
particular problem.

There are numerous languages that programmers can use to specify
instructions. Each language has its different features, benefits, and
usefulness.

* We will start with Excel VBA but also study Python and R.

The goal is to understand fundamental programming concepts that
apply to all languages.

A variable is a name that refers to a location that stores a data value.

Location Age = Variable

Location
(box)

1849— Value

IMPORTANT: The value at a location can change using initialization or
assignment.
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Variable Assignment
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Excel Variables

Assignment using an = sets the value of a variable.

Every variable in Excel has a name and a data type.
* Variables increase code efficiency and readability.

¢ Data types: Boolean, Currency, Date, Double, Integer, Long,
Example: Object, String, Variant (any type)
num = 10
num = Range ("Al") .Value Example:
num = 20 Dim num As Integer
DATA 301: Data Analytics (27) DATA 301: Data Analytics (28)
Collections

Variables Question

Collections are variables that store multiple data items. Data items
can either be indexed (selected) by name or number.

Example:
Worksheets ("macro")
Worksheets (2)

Worksheets is a collection as there may be multiple worksheets in
the workbook. Select one by name or number (starting with 1).

Question: How many of the following statements are TRUE?

1) A variable name cannot change during a program.

2) A variable value cannot change during a program.

3) A collection is a variable that can store multiple data items.

g) A value in a collection can be retrieved by name or by index starting from

5) In Excel, variables are declared using DIM.
6) In Excel, variables are declared with a data type.

A)O B) 1 C)2 D)3 E)4
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Decisions
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Question: Decisions

Decisions allow the program to perform different actions in certain
conditions.

* Logical operators: AND, OR, NOT

Excel decision syntax:

If condition Then If condition Then

Statement statement
End If Else
statement
End If

Question: What is the output of the following code?

Sub TryIf()
Dim num As Integer
num = 20
If num > 10 Then
Debug.Print nua * S

Else
Debug.Print num * 2
End If
End Sub
A) 100 B) 40 C) 20 D) error — no output
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Try it: Decisions
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Loops and Iteration

Question: Create a method called EchoDecision that asks user a
Yes and No question and outputs a message either "Yes" or "No"
depending on what they chose.

Sub EchoDecision()
Dinm answer As Integer
answer = MsgBox ("Pick Yes or No!", vhYesNo)
will either he

iebug.print to out

A loop repeats a set of statements multiple times until some condition
is satisfied.

* Each time a loop is executed is called an iteration.

* A for loop repeats statements a given number of times.

Excel for loop syntax:

Dim i as Integer
For i =1 To 5

Debug.Print i
Next i
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Question: Loops
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Try it: Loops

Question: How many numbers are printed with this loop?

Sub TestFor ()
Dim i As Integer

For i = 0 To 10
Debug.Print i
Next i
End Sub

A)11 B) 10 C)o D) error — no output

Question: Create a method called TryFor that prints the numbers 1
to 20. Challenging variants:

* Print the numbers from 10 down to 1.
¢ Print only the even numbers from 1 to 10.
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User-Defined Functions (UDFs)
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UDF Example

A user-defined function is your own Excel function that can be used in
formulas like built-in functions.

A UDF must return a number, string, array, or Boolean.

A UDF cannot change the Excel environment including the current cells
or other cells (e.g. change formatting).

UDF doubleIt will double the input argument.

' UDF expect a number to double
Function doublelt (num As Integer)
To return a value, assign the value to
doublelt = num * 2
End Function

the method name
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UDF Example — Sum Cells by Background Color
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Try it: UDF

' Sums all the cells with the same color

Function SumColor (RangeToSum Ais Range, ColorID As Integer) As Long
Dim ColorCell As Range
Dim result As Long

' Loop through each cell in the range.
For Each ColorCell In RangeToSum
If ColorCell.Interior.ColorIndex = ColorID Then
result = result + ColorCell.Value
End If
Next ColorCell

SumColor = result
End Function

Question: Create a UDF called CountNum that will return a count of
the number of digits (0 to 9) in a string.

DATA 301: Data Analytics (39)

Advanced: Object-Oriented Programming
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Excel Objects

Object-oriented programming structures code as object, classes,
methods, and properties. This organization makes it easier to
understand and construct large programs.

An object is an instance of a class that has its own properties and
methods that define what the object is and what it can do.

A class is a generic template (blueprint) for creating an object. All
objects of a class have the same methods and properties (although the
property values can be different).

A property is an attribute or feature of an object.

A method is a set of statements that performs an action.

Excel structures everything as a hierarchy of objects, and commands
are done by running a method of an object.

An object may contain other objects as well as methods and
properties. A dot "." is used as a separator between objects and
subobjects, methods, and properties.

Examples:
* Top-level object: Application
* Workbook —individual Excel file
* Worksheet - sheet in a workbook

Application.ActiveWorkbook.Worksheets ("macro") .Range ("Al") .Value
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Excel Range Object
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Excel Object Methods

The Range object selects a cell or group of cells.
Example:

Worksheets ("Sheetl")
.Range ("Al1:C3") .Font.Italic = True

Methods perform an action.

Example:

Worksheets ("macro") .Activate
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Object-Oriented Question
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Try it: Excel Objects

Question: How many of the following statements are TRUE?

1) A method can have no parameters.
2) Two objects of the same class have the same properties.

3) Two objects of the same class may have different values for their
properties.

4) Workbook is the top-level object in Excel.

A)0 B) 1 C)2 D)3 E) 4

Question: Using the Immediate window try to perform the following
actions with methods on Excel objects:

1) Switch the active worksheet to form.

2) Switch the active cell to macro sheet A4.

3) Use msgbox to display value in current cell (ActiveCell).
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Forms and Input Controls
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Input Controls

Excel allows the creation of forms with controls for a better interface.

A B €

Two types of controls in Excel: 1 Name: | +— textbox

* Form controls — default 2 2 a a

 ActiveX controls — allow more flexibility and customization 3 |Age: Ll FOP own

4 | Owme @ Female \h.st box
) ) 5 | Bowsar = checkbox radio buttons
Controls can be inserted from the Developer tab. Select Insert, pick 6
control, and then click and drag the size and shape of the control on 7 l Click Here!
the spreadsheet. —
button
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Events Conclusion

An event is a notification to your program that something has
occurred.

Events in Excel:
* add a worksheet
* double-click on a cell
* change a cell value
* calculating a formula
* click on a button (can execute a macro)

Worksheet-level events on a particular worksheet and workbook level
events for entire file.

Microsoft Excel VBA allows for automating tasks in Excel and provides
a full programming environment for data analysis.

Macro record a set of actions so they can be easily executed again.
* Be aware of security risks when using macros.
The Visual Basic Editor (VBE) is a complete integrated development

environment for editing macros, user-defined functions, and adding
forms and controls that dynamically respond to events.

Excel VBA uses object-oriented programming that structures code as
object, classes, methods, and properties. A developer can control and
automate everything with Excel using VBA.
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Objectives
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List some reasons to use Excel VBA

Define macro and explain the benefit of using macros

Be able to record and execute a macro

Explain the security issues with macros and how Excel deals with them
List and explain the use of the four main windows of the Visual Basic Editor
Explain the role of the object browser

Explain and use the WITH statement syntax

Be able to write simple macros using the VBE

Define: algorithm, program, language

Define: object-oriented programming, object, class, property, method
Understand and use dot-notation

Use the Range object to select a group of cells

Define: variable, value, location

Objectives (2)

Create and use Excel variables

Explain how a collection is different from a typical variable
Use If/Then/Else syntax to make decisions

Use For loop for repetition

Create user-defined functions and use them in formulas
Define: event

List some typical user interface controls

Understand that Excel allows for forms and controls to be added to a worksheet
which respond to events




